Ignite OP™ User Manual

Version 12.01

52243

Sign Configuration
Follow the Auto Configuration instructions on page 2 to quickly configure Ignite.
Job Site Name: ____________________________________________________________________________
Sales Order Number: _______________________________________________________________________
Sign Model: __________________
Sign Faces:

Matrix: Height _____________ Width____________

o Red

Sign Controller Type*: o RWF Radio
		(Ethernet)

o Amber

o Color

o Broadband DSL

o Phone Modem

o High Speed Fiber
o RWF Walk-Up
WPA2 Key:_____________
		(Ethernet)		(Ethernet)		
o Fiber XVS w/Live Video o Broadband Wireless
		(Direct Connect)		(Ethernet)						
					
IP Address: _______ . _______ . _______ . _______
Sign Controller Model:______________________________________________________________________
Specific Features (installed options are check-marked):
o Temp Sensor (standard)
o Paid Software Training**
o Dell PC & Monitor
o Fiber Crossover cables
o Temp Sensor/Photo cell
Other options: __________________________________
Total Single-phase Electrical Service: ________ Amps

o 120 Volts o 240 Volts

Service per Face: ________ Amps
Sectional signs: Amps per section: 1: _____ 2: _____ 3: _____ 4: _____

Most communication methods are packaged with a separate, more detailed manual.

*

Schedule convenient, online training at watchfiresigns.com/ist.

**
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Quick Setup for Auto Configuration
The Auto Configuration Wizard attempts to connect to the sign in order to download the configuration details from the
sign controller. Follow these simple steps to configure Ignite and connect to the sign.
1.

Be sure the sign is turned on. It should be playing a default message.

2.

Install Ignite on the host PC. If the sign does not have power, choose Manual Configuration Page, and refer to the
inside cover for Sign Configuration.
Note: Auto Configuration is preferable. If possible, wait for the sign to be powered on.

3.

Watchfire offers many communication options. Choose the appropriate sign communication method from the three
options below and follow those instructions.
Note: For RWF Walk-up radio, please see page 31 of the installation manual or the RWF Radio Walk-Up guide (Answer 1544 on watchfiresigns.com/kb).

a.

RWF Radio, High Speed Fiber or HSR: If the sign has High Speed Fiber, RWF Radios or HSR, connect the
equipment to the host PC at this time. The drivers will install automatically. Click the Click Here link on the Auto
Configuration Wizard. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Host Computer
Fiber
Router

Fiber Media
Converter

Contro
ll

er

Fiber Cable

High Speed Fiber

RF Receiver

Host Computer
RF Transmitter

RWF Radio / HSR
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Contro
ll

er

Broadband Wireless, HSR, High Speed Fiber set to a static IP on the network, or RWF Radios that have
been programmed to a static IP on the network: If the sign has Broadband Wireless, HSR, High Speed Fiber or
RWF Radios that have been programmed to a static IP on the network, click Network Connect Page and enter
the static IP. Click Next. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Cellular Antenna

Host Computer

Internet
Connection

Broadband Wireless

Network
RF Receiver

Host Computer
RF Transmitter

Contro
ll

er

RWF Radios/HSR Programmed to Static IP on the Network

Network
Host Computer
Contro
ller

Fiber Interface

Fiber Cable

High Speed Fiber Programmed to Static IP on the Network

c.

Phone Modem: If the sign has phone modem communication, connect the phone line to the host PC modem and
click Phone Connection Page. Select the modem from the drop down menu and enter the phone number with
appropriate prefix and area code. Click Next. The Wizard will attempt to connect to the sign and download the sign
configuration. If communications are established, the Auto Configuration Successful screen will appear. Click Finish.
The communications are now properly configured to schedule messages and update the sign.

4.

Once Ignite has been configured for the sign, install the EasyArt Graphics by inserting the included EasyArt disc. The
correct size of EasyArt will be installed.

If the Ignite Auto Configuration Wizard fails to connect to the sign, the Auto Configuration Failed message will appear.
Check connections and power to the communication equipment and be sure the sign is playing a message before
clicking Retry. If the problem persists, click View Log and review the error messages for possible solutions. View the
“Troubleshooting Auto Configuration” help answer on watchfiresigns.com/kb for further steps.
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QUICK TIPS • Be sure to check this section on each page for even more useful information and time saving tips.
BE AN EXPLORER • Take time to explore each of the sections and experiment with the different features of Ignite so
that creating content for your sign will become an enjoyable experience for you and a key tool
for your organization.
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Introduction

Ignite software helps you to perform three main tasks:
1.
2.
3.

Creating and editing messages.
Scheduling messages for playback at any time or date.
Sending messages and schedules to your Watchfire sign.

Ignite software comes with a large library of professionally designed EasyArt, including graphics, animations and video
clips. This outstanding art collection, available exclusively to Watchfire sign owners, will bring added attention to your
sign, making your business stand out.
Ignite also contains advanced messaging capabilities including importing images and animation files to create your own
custom messages.
This manual is designed to help you to understand some of the basic features of Ignite, and will get you started in
creating quality, eye-catching content for your Watchfire sign.

The Watchfire KnowledgeBase
Our online KnowledgeBase contains many tips, tricks and solutions beyond the scope of this manual. As our experience
grows, we incorporate more content daily. Visit the KB for:
1.
2.
3.
4.

Ignite walkthrough videos
How-to articles on both basic and advanced topics
Troubleshooting guides
Quick access to a Watchfire technician through the Live Chat tab

Visit the KnowledgeBase at watchfiresigns.com/kb.
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Welcome to Ignite content management system for your new Watchfire® sign. Our powerful, smart Ignite software is an
easy way for you to quickly create your own attractive, professional looking messages and then display them on your sign.
Best of all, computer programming and design experience are not required!

Helpful Hints
Congratulations on being chosen to help with the task of putting messages on your Watchfire sign. Before you begin,
here are some helpful hints that will assist you. They will make the time you spend learning how to use your Ignite software
more enjoyable and productive.
Don’t worry about whether you will be able to operate your Watchfire sign. It is a lot easier than you think!
Read the entire manual and follow the “Try It Out” Activities. Our Ignite manual is a quick, easy read and the activities
are easy to follow. If you skip sections, you may miss out on key features of your new sign and Ignite software.
Do the “Try it Out” Activities for each section in order. We have designed them to build on each other.
Experiment with the different tools within Ignite. Hands-on experience is the best way to learn. With a little practice you’ll
be on your way to creating a great looking sign in no time!
Once your messages are on the sign, go look at them from several angles and distances if possible. This will give you a
much better idea of what the public sees.
Watch how long each message stays on the sign. Your location and the size of your sign will determine how long someone
passing by your sign will be able to read it. Refer to the Art and Design Guide for useful, time saving guidelines.
Text, graphics and backgrounds will need good color contrast to look their best. The Art and Design Guide will help point
you in the right direction.
As you learn, remember to be realistic and patient. At first you might have success with only basic messages, then build
on your skills through trial and error. You will discover which fonts and graphics communicate well on your sign — and
which don’t. The best way to learn what works is to try something, then update your sign and go have a look.

LET US HELP • Remember, you are not alone. We are here to help if you get stuck.
TECH SUPPORT • e-mail: service@watchfiresigns.com | KnowledgeBase: watchfiresigns.com/kb
Live Chat: watchfiresigns.com/chat
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Program Elements
Task List

Help Web Help

Menu Bar

Toolbar

BEFORE YOU BEGIN

Messages

Messages Buttons

Recent Message Buttons

Tips

Messages: Brings you back to the main Messages screen.
Menu Bar: Contains available program commands.
Toolbar: Displays common commands for quick access.
Message Buttons: The six different methods for creating and editing messages are found here.
Task List: Quick access buttons that take you to the three main tasks used for displaying messages on your sign.
Tips: Displays helpful tips to assist in using your sign effectively.
Recent Message Thumbnails: Easy access to your last ten messages.
Help: Opens up the local help topics that came with your software.
Web Help: Brings you to the Watchfire KnowledgeBase on the web. Unlike the internal Help pages, the KB is updated
regularly. The KB offers advanced tips, troubleshooting guides and access to a Watchfire tech through the Live Chat option.

DON’T GET LOST • The Messages, Schedule and Update buttons in the toolbar are always available for you to navigate to these three main
tasks. The name of the section you are working in is displayed just below the toolbar.
HELP IS HERE • Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC has Internet
access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire KnowledgeBase!
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Message Editor Toolbar
This is the toolbar that appears when editing any message.
Undo		

Task List

Current Message

Add

Open Messages

Copy to Next Spell Checker

Insert

Delete

Preview

Close Current Message

Task List: These buttons quickly take you to any of the three main screens in Ignite.
New: Quickly create a new message. The new message will open in a new tab.
Open: Open an existing message to edit it.
Undo: Undo the last change.
Cut, Copy and Paste: Cuts, copies or pastes a selected frame. The paste function will overwrite the selected frame.
Add: Adds a blank frame at the end of the message.
Insert: Inserts a blank frame above the selected frame.
Copy Down: Copies the selected frame to the frame below.
Delete: Deletes the selected frame.
Spelling: Runs spellcheck. (Only available in 32bit installations of Ignite.)
Preview: Previews all frames of the current message to see how the message will play on the sign.
Help: Opens the local help article for the Message Editor.
Web Help: Opens the Watchfire KnowledgeBase.
Current Message: The message you are currently editing will have a selected tab.
Open Messages: Any open message can be selected by clicking on its tab.
Close Message: Closes the current message.
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“Try It Out” Activity Preview

Let’s try a sample “Try It Out” Activity on navigating through Ignite.
Navigating in Ignite
There are three main tasks in the Ignite software: Creating (and editing) Messages, Scheduling
Messages, and Updating your Sign. Each task has a large button in the Task List area. Each task also
has a smaller corresponding task button in the upper left hand corner of the Toolbar that is always
available at each point in the program. By using the buttons you can seamlessly jump from one part
of the program to another.

BEFORE YOU BEGIN

This manual contains a series of “Try It Out” Activities to guide you through your first experiences with Ignite and help you
understand the capabilities of the software. The activities will give you hands-on experience creating and sending messages
to your sign. They are designed to be done in order with new skills building on ones you have just mastered.

“TRY IT OUT”
ACTIVITY

1.

Click on the large Messages button in the Task List section at the left of the Messages screen. This is Ignite’s
main screen.

2.

Click on the Messages button in the upper left hand corner of the toolbar. You will notice nothing happened.
This is because the Messages button on the toolbar and the Messages button on the Task List take you to the
same place; the Messages screen. This is also true of the Schedule buttons and the Update Sign buttons.

3.

Click on the large Schedule button in the Task List section. Now click on the small Schedule button on the
toolbar. They also perform the same function.

4.

Click on the Messages button in the upper left hand corner of the toolbar. Anytime you are not sure where
you are, this button will take you to the Messages screen.

5.

Click on the large Create New Message button. You will notice the large buttons are now gone. But if you look
on the toolbar in the upper left hand corner, all three task buttons are still available.

It is Safe to Practice
In order for any message to be displayed on your sign you must carry out the Update Sign step. We will not instruct you
to update your sign with the sample messages you create except in the first section entitled Making Your First Message.
Experiment with different kinds of messages, using different Appear Effects and Hold Effects to achieve variety in your
work. Explore the EasyArt library that comes with your sign, and learn how these pre-made graphics, animations and
video clips can help you create eye-catching content for your sign.
If you have a schedule already prepared, see the Frequently Asked Questions section, for guidelines on saving your
current schedule for recall after your practice session. Try the different ways of listing messages (daily, weekly, and
on specific dates) to get a feel for how they interact with each other. When your practice session is done, follow the
remaining steps to recall your original schedule (if necessary).

START FROM MESSAGES • When you begin a “Try It Out” Activity, click on the Messages button in the upper left hand corner of the screen
so you begin each activity from the Messages screen.
DELETING MESSAGES • See the note in the File Manager section to delete practice messages and any others you may create over time
after you are done with them.
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Setting the Date and Time
When your Watchfire sign is started up for the first time, the date and time will need to be correctly set.
1.

With Ignite open, begin by clicking Tools in the Menu Bar at the top of the Messages screen.

2.

Select Tools > Configuration. You will then see the Configuration Summary screen which lists some details of
your Watchfire sign.

Change Date & Time Button

3.

Click Change Date & Time.

4.

Enter the current date and time, or click the Current Time button (this option will set the time to match the time
on your computer). Then click OK. Your sign’s date and time are now correctly set!

5.

Clicking the Messages button in the black toolbar will disconnect from the sign and return you to the
Messages screen.

TIME SAVER • Once your sign is installed and the date and time are set for the first time, its back-up system will maintain
accurate date and time during short power outages.
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Making Your First Message
12 Creating a Text Message
16 Making a Basic Schedule
18 Updating Your Sign
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Creating a Text Message
Ignite’s Message Editor can help you quickly create a simple text message. The editor also makes advanced functions and
customizations readily available.

“TRY IT OUT”
ACTIVITY

Using the Message Editor is as simple as point, choose, and click. In this first “Try It Out” Activity, you
will learn to create your first message. Simply follow the easy step-by-step instructions provided here.
Let’s get started making your first message.

1.

Click on the Create New Message button on the Messages screen.

2.

Type the word “WE’RE” in the text box found in the lower left corner of the screen. Your word should appear in
all capital letters in the Preview Window in the center of the screen. This is the default setting in Ignite because
capital letters are much easier to read from farther away. If WE’RE is not in all capitals, go back and change it.

3.

Now look to the right of the text box. You will find a list of text properties you can change. Each item has a
drop down menu that allows you to modify the text’s appearance.

4.

Click on the Font menu and choose Standard Narrow. Notice in both the Preview Window and the Frame List,
the text became narrower. A narrow font lets you get more letters on a line by squeezing the letters together.
Try switching to Watchfire Sans. Now select a font of your choice.

Preview Window

Frames List

Properties

Text Box

5.

Make sure your font weight is set to bold. Bold is selected when the B button is selected. The only reason to
not use bold is when trying to squeeze extra letters on a line. Even then, you are better off trying to use a
narrower font before turning off Bold. Bold letters, like capital letters, are easier to read.

QUICK START BUTTONS • Ignite’s Quick Start options are shortcuts that open the message editor in a state ready to create
a Text, Image or Animation message.
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If you like, you can now adjust the color of the text and the color of the shadow (border) by clicking on the
appropriate drop down menu. You will be able to see the difference between each adjustment in your preview
window and in the frames list.

7.

Click on the Left Justification button. Observe how the text shifts.
Click on the Right Justification button.
Set the Justification back to center for this exercise.

8.

Once you are done making adjustments to the text, click on the Effects tab.

9.

First set the Hold Time to 1 s (one second) or longer. In the Appear drop down menu, start at the beginning of
the list and preview each option to see what it does in the Preview Window. An Appear Effect will animate the
frame as it comes on the sign.

MAKING YOUR
FIRST MESSAGE

6.

Note: If you choose Random Effect, you will not be able to set the Hold or Exit effects. They will become random also.

10. Once you have previewed all of the options, go back and select Wipe.
11. Go to the Appear Direction drop down menu and again, preview each option. Once you have previewed all
the options, go back and select East.
Note: Some Appear Effects will not have an Appear Direction.

12. Now preview the options in the Hold Effect menu. Hold Effects will animate a frame while it is on the sign.
13. Leave the Hold Time set at 1 s.
14. Click on the Exit Effect and select Move. Move will give your message a nice transition to the next frame
or message.

Note: The Blank exit effect will blank each frame as it transitions to the next. The Stay effect will hold the current frame as the new one
comes in.

15. Click on the Background tab. Use the drop down menu to change the background color. The default
background pattern is a solid fill, but this can be adjusted here.
16. Click on Add in the black toolbar. This will add a second frame to your message.
17. Click on the Text tab. Type the word ‘OPEN’ and then click Preview in the black toolbar. You will notice the
program has set all the effects properties of the new frame to match those you made in the first frame.

UPPER CASE • Avoid mixed case messages and lower case messages. Use upper case letters whenever possible because they are much
easier to read from farther away.
DELETING FRAMES • You can only delete frames using the delete button on your toolbar. Using the delete key on your computer’s
keyboard will not delete any frames.
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18. Click on Add again. This will add third frame to the list.
19. On the Text tab, click on the Time button. In the pop-up window, select the time format you like best and
then click OK. If you click OK before choosing from the options, it will automatically choose 12-hour time, the
default format.
Note: Always use the time, date or temperature buttons if you want the element to update automatically. If you manually type the time,
for example, into the text box, it will not update automatically.

20. You can select different text properties here if you like.
21. Click on the Effects tab. Set the Effects properties as you like.
22. Click on Add one more time.
23. Click on the Date button and add the day of the week. The Date button—like the Time and Temperature
buttons—will create a frame that changes as the date changes. Be sure the font you choose allows you to view
the entire text, allowing for the longest possible date that may be scheduled to appear. Drag the text box to
the upper-left corner of the frame.
24. Click on the Temperature button.
If your sign has a temperature sensor, leave Sensor at Sign selected.
If your sign does not have a sensor, select NOAA RSS Feed. Click the Enable button to start Data Link with the
default RSS feed settings. Select the closest airport from the Weather Station dropdown list.
From the menu, select how you want the temperature to appear and click OK. The temperature displayed on
your computer will always be 68°, the placeholder value. The sign itself will read the temperature sensor and
display the correct temperature on your sign, but this information will not be relayed back to your computer.
Drag the temperature box to the lower right corner of the frame.
Note on NOAA feeds: Ignite will support one RSS feed per message. If you would like to draw content from another feed, you will have to
deactivate this feature by clicking on Sensor at Sign as the Temperature Source or create another message. The NOAA RSS Feed feature
requires that the computer be connect to the Internet and run Data Link 24 hours a day. The NOAA feed may provide a placeholder other
than 68.0 at times, but it will often be outdated when shown in Ignite.

SENSOR OR FEED? • If your sign has a temperature sensor, it’s best to use it instead of a NOAA feed. The nearest NOAA
station is often many miles away.
DO I HAVE A SENSOR? • Check the front inside cover of this manual to see if a temperature sensor was ordered with your sign.
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25. Make any desired text property, effect and background changes.

MAKING YOUR
FIRST MESSAGE

26. Before saving the message, click on the frame you would like to set as the thumbnail image from the frames list.
Now click Message on the Menu Bar and click Set Thumbnail Frame. The thumbnail will always default to the
first frame unless you set it differently. If the first frame is the one you want, you can skip this step in the future.
27. Click the Save button in the black toolbar.
28. Name your message and give it a description that will help you find it easily in the future. You can further
distinguish your message by assigning it to a category from the list. You can also create your own category by
typing in the Category field.
29. When done, click Save. This will save the WE’RE OPEN message so we can use it in one of the future exercises.
You did it! You just created your first message. It’s just that quick and easy to create basic text messages for your Watchfire
sign using the Message Editor. Now that you have created your first message, it’s time to see what it looks like on your sign.

COPY CAT • In the Message Editor, each additional new frame will have all of the properties copied from the previous frame.
HOLD THE SYMBOLS • In your message file name avoid using symbols such as : < > / \ ? * “ | . They can cause the message to either not
work or work improperly.
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Making a Basic Schedule

“TRY IT OUT”
ACTIVITY
1.

So, you are ready to try out your new message on your sign? Great! Adding messages to the
scheduler is necessary before you can update the sign. Let’s create a basic schedule and put it to
work on your sign. In a later section we will discuss in detail all the ways you can schedule messages.

Click the Schedule button on the main Messages screen.
This will open the scheduling section of Ignite. There may be some messages in the scheduler as defaults from
the factory or your sign company. If you wish to keep this schedule, refer to the Frequently Asked Questions
section for information on how to save your existing schedule which can be reloaded later.

2.

Click on a Play List name, if one exists, to highlight it. Click the Remove button to remove that file from the
list. Repeat this step as necessary until your schedule window is empty.

3.

Click the Add button at the top of the screen to open the Play List Details window.

Section Tabs
		

Details
		
		
		
Play List

CUSTOM CATEGORIES • You can create your own custom categories like “MY CUSTOM ART” to help organize the messages
you have created. Simply type your new category name in the Category field under the Save step. Your new category will
now appear on the category list any time you go to save a message!
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The When tab is where you decide when you want to run your messages. For this exercise, select All Day and
All Dates under the Time & Date section and Every Day of the Week under the Days of the Week section. This
will make your messages play 24 hours a day, every day.

5.

Click the Messages tab to display a list of all available messages, including the one you created in your first
“Try It Out” Activity. The messages are shown in the List view by default. Change this to suit your preference.

6.

Click on the thumbnail of the WE’RE OPEN message you created in the last activity then click the Add button
to add it to the Play List at the left of the window. You can also add messages to the Play List by doubleclicking the file name.

7.

Click the EasyArt tab to display the list of available pre-made animated messages provided with your system.

8.

Scroll down the list to find the Clouds message. Double-click the File Name to add it to the Play List. Scroll
back up and do the same for the Act_Now_Stage message.

9.

Click the Save button in the upper-left corner of the window to create this Play List in the scheduler.

10. You are now back at the Schedule screen.
Notice that the three messages you added to the Play List are grouped together under the heading “Play List A”. If you
click the Plus Sign (+) next to the Play List name it will reveal the three messages in the Play List. Click the Minus Sign (-)
to hide the messages again.
The brown bar across the timeline indicates that these messages will play All Day, Every Day as indicated in the bar’s label.
By double-clicking on a filename in the schedule, you can open that file in the appropriate message editor. If you doubleclick the schedule name, it will open the Playlist Details window.

You have now successfully created your first schedule! Now all you have to do is send your new schedule to your sign.
We’ll do that in the next step: Updating Your Sign.

TIME & TEMPERATURE • It’s a good idea to have a time or a time and temperature message in every schedule. They will help the public get
used to looking at your sign whenever they pass by it.
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4.

Updating Your Sign

“TRY IT OUT”
ACTIVITY

Now that you have created a schedule, you are ready to connect to the sign. Your schedule will tell
it what messages to run and when. If you do not have a schedule ready to put on your sign, refer to
the Making a Basic Schedule section to set up a schedule.

1.

Begin by clicking the Update Sign button found on the main Messages screen.

1.

Type your password into the Password Box. If you haven’t set up a sign password yet, refer to the Password
Protect Your Sign section on page 63. Using a sign password is a security best practice.

Select the Remember Password checkbox to automatically fill in your password on this PC only.
2.

Click Update All Messages to open the communications window and display the progress of the update.

3.

When the update is successful, you will see the message below. If an error occurs, the communications
window will stay open.

Congratulations! You have now put your schedule of messages on your Watchfire sign. No matter how simple or intricate
your schedule may be, you will always use this same easy method to update your sign. If possible, we recommend looking
at your sign to be sure your new schedule is running the way you want it to.
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Once your sign has successfully updated, a graph of the estimated drive space usage on the controller will appear
automatically. Just like a computer or a digital camera, there is a limit to how much information your sign can hold. The
File System Usage graph will help you keep track of the available space on your controller.

MAKING YOUR
FIRST MESSAGE

The File System Usage graph breaks the drive space usage into four separate categories.
1.

System Files: total drive space consumed by all files that are not message, schedule, or font files.

2.

Messages & Schedules: total drive space consumed by messages & schedule (this size is determined from the current
schedule not the actual controller itself ).

3.

Fonts: total drive space consumed by font files (this size is determined from the current schedule not the actual
controller itself ).

4.

Free Space: total space available on the controller for additional messages, schedules, and fonts.

You also have the option to see a more detailed analysis of how the available space is being used. The File System Details
report displays the messages, schedule, and fonts in each schedule. Each message, schedule and font file in your current
schedule is listed with the file size and the percentage of drive space it consumes, allowing you to make decisions on
content that will maximize your available space.

WATCH YOUR SPACE • Not all messages are created equal when it comes to using up space on your sign controller. Messages that use
animation, TrueType fonts, or large size picture files will fill the controller space more quickly than other messages.
TRUETYPE FONTS • Using just a handful of TrueType fonts among all of your messages will save space too. Once a font is loaded to the
controller, it will be shared to every message that uses it. Using many different TrueType fonts will utilize more space.
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To view the File System Details, simply click the red Show File System Details link at the bottom of the File System Graph.
In addition to the File System Graph and File System Details reports, your Ignite software will also issue a warning if a new
message or schedule will exceed the available space on the controller. Any time you click the Update All Messages button,
Ignite will scan the controller and calculate the remaining available space. If a new message or schedule is too large, the
Controller System File Space Warning will appear automatically.

When the warning box appears, you will have the option to Proceed or Cancel. Choosing Cancel will stop the update,
allowing you to modify your schedule to a file size the controller can accommodate. If you choose Proceed, the update
process will continue, but the system will only send the files that will fit on the controller, meaning some schedule files
will not make it to the controller. In this case, the report will track the files that were and were not uploaded, and the
detailed report will show files that failed to upload in red.

TAKE CONTROL • Remember, when a schedule update experiences an error, the File System Graph WILL NOT display
accurate information. The graph is based on the schedule, not what is actually on the controller. Click Update All Messages
again to attempt a successful update, which will provide accurate information.
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Importing Images
One of the great features of Ignite content management system is the addition of quick and easy importing wizards. You
can easily add pictures, logos and short animation and video clips to your messages. Let’s try importing an image and
making it into a message you can play on your sign.

“TRY IT OUT”
ACTIVITY

We will use a picture for this exercise, it could also be a logo or still art you have found or created.
Note: Compatible file types include Bitmap, GIF and JPG.

1.

Click on the Quick Start Image button on the Messages screen of Ignite.

2.

Choose a picture to import by clicking the Browse... button. The program will go to the last folder you
imported from. Highlight the image you want and click Open.

Browse Button

Source Image

Preview Window

3.

You now see your Source Image in the main window and a preview of your image at the bottom of the screen.
Also, notice the frame added to the Frames List along the left side of the window.

CROP BEFORE IMPORTING • It is easier to scale your images down and do any cropping in a photo editing program
before you import them. This will also help the graphic’s final appearance on your sign.
DISPLAYING A LOGO • If you want to import graphics, like a logo, you might want to position your image to just cover part
of the preview window, leaving room for adding text later.
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4.

Leave the color conversion set on True Color - Halftone (or Grayscale - Halftone) rather than True Color - Color
on Color. You may want to test both settings to see which is best for importing your picture.
Note: When scaling images to fit your sign, the Halftone option blends pixels together creating softer edges; Color on Color removes
pixels which creates sharper edges.

We have provided several Scaling Factors to help manipulate your image. Click through each one and watch
how each setting changes your image on the frame preview.

6.

If you move your mouse pointer over the Source Image, you will notice that it turns into a crosshair. You can
left-click and drag your mouse over the Source Image to define a Selection Rectangle. This crops your Source
Image and makes that portion of your image larger in the Preview Window.

7.

The edges of the Selection Rectangle that you created can be adjusted by clicking and dragging the dashed
line. The preview below will update in real time. Try using a combination of the Selection Rectangle and
Scaling Factors to achieve the look you want in the preview window.

8.

Once you’re happy with how the image looks in the preview, click Import.

9.

You can position your image by left-clicking anywhere in the Preview Window (your mouse cursor becomes a
crosshair with four arrowheads) and dragging your mouse. For example, if you wanted to add text to the right
half of your screen, you would drag the image to the left so the right half is black in the preview. You can also
adjust the size of your image by left-clicking on any of the eight Image Positioning Marks (your mouse cursor
becomes a crosshair with two arrowheads) and dragging your mouse.

10. If you would like to add any text, you may do so now. You could also add the Time, Temperature, or Date by
using the appropriate buttons.
11. Click on the Effects tab and choose your desired effects.
12. Click Preview in the black toolbar to see how your message would play on your sign.
13. Once complete, click on Save in the black toolbar. Give your new message a File Name (and Description or
Category if desired). Click Save. Your message is now ready to schedule.

GRAPHICS FOLDERS • It is a good idea to create a special folder for storing all of your graphics, pictures, logos and animations. This way
you don’t have to hunt for them when you get ready to import.
DESCRIBE WELL • The description field comes in handy when your message contains multiple frames and elements. Add details to indicate
what your message contains so you don’t have to sit through a preview in order to figure it out later.
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5.

Importing Animations
One of the best things about your Watchfire sign is its ability to show motion or animation. Your Ignite content
management system came with many pre-made EasyArt animations. You may discover many messages that will be
valuable to your schedule. You may also find that you would like to put an animation on your sign that is not available in
EasyArt. We have included Quick Start Animation in Ignite to help import video files, overlay text, and save them to be
used as new messages.
Note: Import Animation requires an appropriate codec to be installed on your computer to support reading video data from the file. In addition to
the codecs Microsoft ships with Windows, many third party codecs are available to support a wide variety of video file formats. Visit article 706 on the
Watchfire KnowledgeBase for a full list of compatible codecs. (Go to watchfiresigns.com/kb and search 706.)

“TRY IT OUT”
ACTIVITY

Be sure you have a video file on your computer ready to go. If you need a video file for this activity,
one can be found in the Tutorial Graphics folder within your Ignite installation folder.

1.

Click on the Quick Start Animation button on the Messages screen.

2.

Choose a video file to import by clicking the Browse... button. If the file you are searching for does not display
in the dialog, try selecting All Files in the file filter dropdown located near the Open button.

3.

Highlight the file you want to use and click Open.

4.

You can click the Play button to preview the source file. You can also use the Time Slider to “scrub” back and
forth through the animation/video.

5.

Leave the color conversion set on True Color - Halftone (or Grayscale - Halftone) rather than Color on Color.
The halftone setting will provide the best results most of the time.

6.

Click and drag over the Source Image to create a Selection Rectangle if you don’t want to use the entire
image. Then choose a Scaling Factor that appears the best. You can view the result in the Preview Window.
Adjust these parameters as necessary.

7.

Click Import when you are happy with how the preview looks.

8.

You can overlay text, Time, Temperature or Date by using their buttons. For this exercise, click on the Time
button. Select the format you desire, position it and adjust the font.

9.

You’ll notice that the Time only appears on the first frame of the animation. Because this would only show for
a brief moment, you need to apply this change to all frames of your animation message. Click on the Utilities
button on the Text tab and select Make Multiple Frames the Same Text Properties.

10. You can choose all of the frames or a range. For this exercise, choose all of the frames and click OK. The change
will be applied to all frames.
11. Click Preview in the black toolbar to view the entire animation message.

HIGH RESOLUTION • If you have a high-resolution animation/video, it is a good idea to scale it down before importing it.
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12. Once complete, click on Save in the black toolbar. Give your new message a File Name (and Description or
Category if desired). Click Save. Your message is now ready to schedule.

Browse Button

Play Button
Time Slider

Source Image
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Preview Window

PREP YOUR FILES • If you have long animation files or files that need to be cropped, it is a good idea to correct them in a video editing
program before importing them.
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EasyArt Messages
Your Ignite software contains a library of pre-made messages called EasyArt. EasyArt messages are a great way to add
interest to your sign. They also serve as a starting point for creating your own customized messages. You will find that many
of these messages will fit into your schedule just as they are. But in cases where they don’t quite fit, many of the EasyArt
messages are designed for simple editing. Several ways of working with them are described in detail in this section.
When you click on the Open EasyArt Message button, a window opens as seen below. Click Category to filter
EasyArt messages by theme. The selector box to the right enables you to see a filtered view of stills, animations
or both. The triangular-shaped Sort Indicator will appear in the column headings area. Clicking on the Column
Name will reverse the sort from A – Z to Z – A and vice versa.
While there are multiple views to choose from, the Details view is recommended while you are learning how to make
maximum use of these animations because it provides the most information.
Search Area

Sort Indicator

View

Preview

EASYART IS SAFE • Don’t worry! You cannot overwrite the original art in the EasyArt library. Whenever you open an EasyArt
message, a copy is automatically created in your messages folder.
FILE SEARCH • To find a specific word or phrase in the EasyArt list, simply type it in the Search field at the top of the Open
EasyArt window and click Search. If found, you can preview and open it. If not, delete the word(s) from the Search field and
click Search again. This will bring back the full list of EasyArt.
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Types of EasyArt
1. Standard messages are not editable. They incorporate professional effects to create eye-catching messages. This is
the most common type of EasyArt message.
2.

Background messages allow you to add your own text over the graphic. Select the Backgrounds option from the
Category drop-down menu to display this group.

You can only change what is not a permanent part of the artwork, so it is important to know the type of message you
are starting with. Using an EasyArt message does not effect its availability for future messages. You can edit and save any
EasyArt message. Even when that message has been deleted, the original EasyArt is still available to you.
There are two basic ways of opening the list of EasyArt. First, from the main Messages screen, you can click on the Open
EasyArt Message button to view the list.
Second, from within the Message Editor, you can click the word Insert in the menu bar at the top and click Import
EasyArt to display the same list of EasyArt messages.

EasyArt For Emphasis
You can open or import any message from the EasyArt list to start your message. You can then add a frame before or after
the EasyArt message to insert your own text. The EasyArt message can act as the eye-catching element of your message
while your added frame provides the information of the message.

MAKING MORE
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Uses of EasyArt
There are several ways you can use EasyArt as a part of messages you create. Listed here are brief descriptions of the basic
techniques you can use with these messages to add interest and appeal to your sign.

“TRY IT OUT”
ACTIVITY

1.

From the Messages screen click the Open EasyArt Message button, and double click on
the file named “OPEN HOUSE” to open it.

2.

Click on the Add button in the black bar at the top of the screen to add a frame at
the end. Type the word “TODAY” in the Text Box. Use the Text Properties to adjust the text size and color to
approximate those of the last few frames of the EasyArt message. Click the Background tab and select a
similar color also.

3.

Click on the Effects Tab and adjust the Hold Time to 1 s or more to keep the text visible long enough to be
read thoroughly. Make other changes as desired to the Appear and Hold Effects.

4.

Click on the Add button again to add another frame and type the words “STOP BY” or something else which
will fit in your sign’s space. Adjust the frame’s hold time and effects as desired.

5.

Click File > Save As to save the message. Name your file OPEN HOUSE TODAY, enter a Description and
Category if desired, then click Save at the lower right of the screen.

EDITABLE MESSAGES • While all EasyArt messages can have text added, messages that lack any graphical text are most compatible with
added, custom text.
MORE BACKGROUNDS • To view all files that are intended for use as backgrounds you must set your Category appropriately. From the
Open EasyArt window, simply set the Category drop-down menu to Backgrounds.
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EasyArt as Sentences
Another way of using EasyArt is to incorporate multiple files from the list to form phrases which create the message you
wish to display.
1.

From the Messages screen, click the Open EasyArt Message button. Double-click the name “SAVE 20PCT”
to open.

2.

Click the Add button on the black bar at the top of the screen to add a frame at the end.

3.

Click Insert in the menu bar at the top of the screen and choose Import EasyArt to display the EasyArt list.
Type the word “saturday” in the Search box at the top of the screen and click the Search button to filter the list.

4.

Double-click the file named SATURDAY to add this piece of EasyArt into your message.

5.

When you’re happy with the message click File > Save As. Give your file an appropriate File Name, Description,
and Category.

EasyArt as Backgrounds
Using the Text Ready and Backgrounds groups eliminates the need to delete text before your text can be added. You can
view just the Backgrounds group by changing the Category to Backgrounds.
1.

From the Messages screen, click the Open EasyArt button to display the EasyArt list. Change the Category to
Backgrounds. Open any file from the list by double-clicking the file name.

2.

Add text in the text box and adjust the properties and the positioning as desired.

3.

Use the Utilities button to copy your text to all of the frames in the message. Select the second option, Make
Multiple Frames the Same Text Properties. Then select all frames or specify a range of frames for your text.

4.

When you’re happy with the message click File > Save As. Give your file an appropriate File Name, Description,
and Category.

ADD A FRAME • When working from an existing message, always add a frame before importing another EasyArt file.
Imports will overwrite the currently selected frame and push subsequent frames down.
HOLD TIMES • Our general recommendation is to hold a frame for one second per line of text. For example, if your
frame has three lines of text, set the hold time to three seconds. That will give passing motorists enough time to read the
entire message.
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Multiple Messages in One
When using an EasyArt file which contains multiple frames, you can create a multi-part message that displays your messages
over time. By having a consistent animated background, your multi-part message will read as a single, unified theme. We
recommend using good color contrast when adding text to an animated background to maintain optimum readability.
From the Messages screen, click the Open EasyArt button to display the EasyArt list.

2.

Open the file “LINES_DANCING” by double-clicking on the name in the list.

3.

Type in the first part of your message, such as “NOW ON SALE,” changing font size and/or style to fit, if
necessary. Click the Utilities button at the lower-right of the screen and click on the second choice, Make
Multiple Frames the Same Text Properties. Change the Last Frame number to 25, and click on OK to change
frames 1 through 25 to your entered text.

4.

Scroll down and click on frame 26. Type the message “ALL BOOKS” or something similar. Again click the
Utilities button. Change the First Frame to 26 and the Last Frame to 51 and click OK to copy that text to
frames 26 through 51.

5.

Use the Preview button on the black bar to judge the effectiveness of your message.

6.

If you wish to continue the message by adding more text, click the Add button to add a blank frame at the end.

7.

Click Insert in the menu bar at the top of the screen, then click Import EasyArt. Find the same background file
we opened and double-click on it.

8.

Now you can put another expression, such as “WED. THRU SAT.” in frames 52 through 77 and “UP TO 20% OFF”
in frames 78 through 102.
Use the same file again as needed to display the complete message, being aware of the total time your
message will require to play through.

9.

This same idea can also be used to make up effective displays of time, temperature, and date.

By using these variations and experimenting with combinations, you can make EasyArt a major part of your message
presentations. They add interest and variety, both key elements in achieving maximum benefit from your sign.

CLICK TO SORT • Any time your EasyArt sort list seems to be out of order, you can change it back to the normal alphabetical list by clicking
on the File Name column heading on the Open EasyArt screen.
EXPERIMENT • Don’t be afraid to experiment. Nothing you create will be displayed on your sign unless you schedule it and click Update Sign.
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Adding Text Boxes
Creating messages with multiple fonts, text sizes and colors can add an extra level of professionalism
and eye appeal to your sign. Ignite allows you to easily incorporate several text boxes into a single
frame, with special effects acting simultaneously on all the text boxes.

“TRY IT OUT”
ACTIVITY

From the Messages screen, click the Create New Message button to open the
Message Editor.

2.

Enter the word “HELLO” in the text box using a font and text size small enough to allow other text in the frame.
Notice that the text auto-centers on the sign image and also appears in the large white text box on the lowerleft of the screen.

3.

Now click Add Text Box. A box displaying the word “TEXT” appears directly above our “HELLO” message. Click
and drag the text box to the lower right corner of the frame.

4.

Click and hover your mouse over the word “HELLO.” Your cursor will change to a four-pointed arrow, indicating
that the word “HELLO” is also a moveable text box. Click and drag “HELLO” to the upper left corner of the frame.

MOVE IT ALONG • Using the Travel Text effect with multiple text boxes allows all text to travel simultaneously. Pick Travel Text as the
appear effect in the Effects tab and set the appear layer to Text. When the message is Previewed, notice that both boxes travel. You can also
apply Travel Text to a multi-line message in a single text box.
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1.

5.

Click “TEXT.” A line around the text shows that this is now the active text box. Go to the white text box and
replace the word “TEXT” with “FANS.” Change the font, text color, and outline color to something other than
those used for “HELLO.”

6.

Notice that the text box automatically resizes to fit these selections. You also have the option to manually
control the size of the text box by clicking the Auto Size button, positioning the cursor along the edges of the
text box until it appears as a double-sided arrow, and clicking and dragging the box to the size you want.

7.

Click the Effects tab. Try different effects and preview the message to get a feel for how the text boxes work.

You now have a message with different fonts in a single frame!

SHORTCUT • When working with text boxes, don’t forget the handy right-click function. Several of the options
made possible with the Utilities tab, as well as text box placement and cut/copy functions, are available by rightclicking on a text box.
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RSS Feeds
Ignite has the ability to display dynamic information on your sign using RSS, ATOM, and XML feeds. This powerful feature
allows you to use existing feeds right from the Internet or allows you to use feeds created on your own.
The RSS Feeds feature works with our Data Link product to perform timed updates of RSS messages to your sign. Once
RSS messages are created and scheduled, Data Link will automatically update them.
Setting-Up Data Link
In order for your sign to get updated with dynamic content from RSS feeds you must first have Data Link configured for
that particular sign.
Follow the steps below to setup Data Link:
1. On the Messages screen, select Configuration from the Tools drop down menu.
2. Select the Sign you want to use to display RSS content using the Signs list on the left side of the screen.
3. Choose Ignite Setup from the Task List on the top-left side of the page.
4. You should see a configuration section named Data Link Setup. In this section you want to select Configure
Data Link > RSS Feeds. Click Save.
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5. After your changes have been saved you are now ready to configure Data Link for updating your sign. Select
the Configure… button in the Data Link Setup section.
6. Set the Time between updates field to define how often the RSS messages will be updated to your sign.

KEEP IT RUNNING • When you’re sign is actively using RSS Feed messages, those messages must be continuously updated from your
PC. Ensure that the PC has constant access to the Internet and does not sleep, hibernate or turn itself off. These settings can be adjusted in
Windows Power Options.
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7. Enter the sign password in the Sign Password field.

8. To schedule the times when your sign can and cannot be updated by Data Link, use the Schedule… button. The
schedule button will provide a dialog to set the days and times you want Data Link to run. This feature is typically
used when using a paid feed source only.
NOTE: Just because Data Link is NOT running does not mean your RSS Feed messages will not be playing as scheduled. They will still be
playing but the content will not be updated.

Creating an RSS Message
Now you’re ready to create an RSS message. Go to Messages.
1. Click File > Create New Message to start designing a new RSS Feed message.
2. In the message editor, click on the Data Link button found on the Text tab. This button is used to add RSS
content to the current message.
Note: If the DATA LINK button is disabled, Data Link is not configured to work with the currently selected sign or your system does not have
the proper files installed to use Data Link.

3. Click the Data Link button to bring up the RSS Feed Wizard. The RSS Feed Wizard allows you to select feeds,
filter feed information and select elements from a feed to display in a message.
a. When you first open the feed wizard you will not have any feeds available to use. You must add the feeds
you want to use. Feeds can be found on the Internet or you can even create your own.
b. You can pull a feed from any place with which your computer communicates. This includes the internet, local
file system, network drive, etc.
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4. To Add a Feed, click the Add button. Then enter the Name of the feed and the feed Address.
a. The Name of the feed is defined by you and is only used for your reference to locate the feed.
b. The Address defines the location or URL of the feed. Just copy the URL from the address bar in your web
browser (example: http://www.weather.gov/xml/current_obs/KCMI.xml).

5. Once you add the feed, Ignite will detect the feed type and place it in the proper list: ATOM, RSS, or XML. Click
on these tabs to find the feed you have just entered.
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6. Select your newly entered feed and click Next >>. The Item Filtering screen will appear.
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7. Item Filtering allows you to define what items from the feed will be displayed on your sign. A feed may contain
multiple items, use this step to refine the items that will get displayed.
NOTE: Items from a feed are displayed one at a time on your sign. If your feed contains 5 items and you choose to display them all it will
take 5 updates of your sign by Data Link before all items will have been displayed.

Play all items in the feed plays every item defined by the feed (no filtering). Each item in the feed will get
displayed on your sign.
Play the item at index allows you to select a single item from the feed to display on your sign. This will only
play one item and the item must exist at the provided index.
Play through the first allows you to set a limit on the number of items that will be displayed from the feed.
Play item no more than lets you display items that are no older than a certain number of days. This option is
only available for RSS and ATOM feeds that provide a publish date for items. Setting this property to 0 means
you will only get items updated on the current day.
Filter playing items based on elements allows you to choose the items to play based on text found in the
elements themselves. This can be useful when you want to display only specific elements.
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8. The last step in the feed wizard is Element Selection. This step allows you to select the text that will be placed
in your message.

Elements List provides a list of elements defined in the feed. You select an element from the list by selecting
the checkbox next to the element name.
Selected Elements shows you what text will be added to your message and the element the text is drawn from.

9. Once you have at least one element selected, click Finish.
10. You can add additional text boxes if you like. You can preview the resulting message by clicking the Preview
button. The preview will display the message just like you would see it on the sign.

11. After you have created your RSS message, click Save and return to the Schedule screen by clicking the
Schedule button. Then update your sign.
NOTE: You must leave you computer logged on and running at ALL TIMES in order for the Data Link application to continue to update your
sign. If you log off or shut down your computer Data Link will not be running and your dynamic RSS messages will not be updated.
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Highlighted Element’s Text displays the text of the current selected element. This gives a preview of the text so
you can decide if you want to include that element’s text in the message.

The Counter Button
The Counter button is another feature unique to the Message Editor. This option allows you to create a count-up or countdown that will automatically update, much like the Date, Time, and Temperature.
1.

Click the Counter button and set the Start Value to the number from which you want to start counting.

2.

Set the Rate to adjust how often the counter will refresh; choose from increments of Second, Minute, Hour,
or Day.

3.

Set the Start Date and Start Time to determine when the counter will begin. The Counter Format allows you
to display your values in terms of numbers, basic currency, or time.

4.

Once your values are set, click OK to preview the counter as it will appear on your sign. The font styles, size,
and colors can be adjusted using the text box just like any other message.

Using the Graphics Tab

“TRY IT OUT”
ACTIVITY

After you have mastered the basics of creating messages, you should begin to explore the ways
Ignite will let you create outstanding special effects in your messages. Mastering and using
techniques made possible from the Graphics Tab while using the Message Editor will open new
doors for you.

1.

From the Messages screen, click the Create New Message button to open the Message Editor.

2.

Click the Graphics tab.

Graphics Tools

Color Palette

Active Colors

Active Colors
Two color boxes are shown to the left of the color palette. These are the active colors you can draw with. Use the left-click
to draw with the left active color and use the right-click to draw with the right active color.
1.

Left-click one of the color swatches in the color palette and you’ll notice that the left Active Color box changes.

2.

Right-click one of the color swatches and you’ll notice that the right Active Color box changes.
THUMBNAIL CHOICE • Be sure to choose the frame you want to show up as a thumbnail. This will make it easier for you to
find your messages in the future. You can set any frame as the message thumbnail. Simply click on the desired frame, then
click on Message (top of the screen) and click Set Thumbnail Frame.
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Pencil, Eraser, and Line
1.

Click on the Pencil button to activate it. You can draw in the message frame one pixel at a time. Left-click to
use the left active color or right-click to use the right active color. You can also click and drag to create a line
which follows your mouse motion.

2.

Click on the Eraser button to activate it. Just like the pencil tool, you can erase the graphics layer one pixel at a
time. Erase some of the Pencil lines that you just created.

3.

Click on the Line button to activate it. With this tool, you can draw straight lines. Click and drag the mouse to
create the line. To create a straight vertical or horizontal line, hold down the Shift key on your keyboard while
you click and drag.

Rectangles and Ellipses
1.

Click on the Outlined Rectangle button to activate it. To draw an outlined rectangle, place the cursor in the
upper left corner of the rectangle desired. Click and drag the cursor over to the lower right corner. The open
rectangle gives you an easy way of drawing a frame around text.

2.

Click on the Filled Rectangle button to activate it. Draw a filled rectangle just as you drew the Outlined Rectangle.

3.

Try the Outlined Ellipse and Filled Ellipse buttons.

Paint Bucket Fill
Click on the Paint Bucket Fill button to activate it. The paint bucket will fill an entire area until it reaches the
edges of that area.

2.

Click on a line or box that you just created. Notice that the paint bucket filled the entire line or box.
If you click in the area that shows the background color, you can fill with your active color.

TOGGLE ON & OFF • When you click on a graphics tool button to activate it, it appears selected on the screen. Don’t forget to go back and
click on it again when done to turn it OFF!
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1.

Rotate 90 Degrees
1.

Click on the Rotation button to activate it.

2.

Click to move the contents of your frame 90 degrees clockwise.

Move Up, Down, Left, and Right
1.

The four double arrow Move buttons to the right of the Rotate button allow you to move the graphics layer
one pixel in either direction with each click.

2.

Click any of the buttons to nudge your graphics layer one pixel in any direction.

Custom Colors
1.

For full color signs, it is possible to create custom colors under the Graphics tab. You will notice a number of
extra black boxes, or swatches, to the right of the color palette. These are empty color swatches and can be
used to store custom colors.

2.

Double-click on one of the empty swatches to display a Custom Color selection window. Slide the three bars of
the primary colors of Red, Green, and Blue to create a custom color which meets your needs. Click OK to make
the new color the left Active Color and to store it in the swatch you started from. You can then put that color
into your message.

3.

You can also use this tool to sample any color visible on your computer screen. Double-click another empty
swatch to bring up the Custom Color selection window again.

4.

Click the Select button to turn your mouse cursor into an eye-dropper icon. You can move the cursor over any
visible color on your computer screen and you will see it previewed in the selection window.

5.

Click on any color you like to sample the color. The color is automatically loaded into the empty swatch.

This is a useful tool if you want to fine tune your graphics. You can sample a color from the image, then use the Pencil tool
to draw over blemishes in an image.

DON’T LOSE IMAGES • When you rotate your graphics layer 90°, it will crop part of the image off. When you click the
Rotation button again, you will notice that your image has been deleted. Click the Undo button to bring your image back.
This will also happen when using the move button.
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Advanced Scheduling
The time will come when you will want your Watchfire sign to do more than just play a set of messages all day and all
night. Maybe you will want to set up different schedules for different days of the week or have a special set of messages
for a holiday. You might want to set up different messages to run for a few hours during the day. This type of scheduling
involves a little extra time and planning, but the result can make your sign a dynamic and exciting tool.
By adding several entries into your schedule, you are building a series of Play Lists which are set to
play at specific times. You can put multiple messages in a given Play List which will play in a topdown order. Play Lists also play in this order.

“TRY IT OUT”
ACTIVITY

1.

Click on the Schedule button on the Messages screen.

2.

Click the Add button at the top of the Schedule screen to display the Play List Details window.

Section Tabs
		

Details
		
		
		
ADVANCED
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Play List

3.

Set the Time & Date to All Day and All Dates and set the Days of the Week to Every Day of the Week. This will
make the message play 24 hours a day, every day.

4.

Click the Messages tab. This lists all of the messages you have created and saved. Click the name of the WE’RE
OPEN message you created to highlight it.

5.

Now click the Add button to put the message into the Play List to the left.

6.

Click on the EasyArt tab and add an EasyArt of your choice.

7.

Click the Save button in the upper-left corner to save this schedule and return to the Schedule screen.

COLOR CODED • Whenever you add an entry to the scheduler, it will assign a color code to the timeline bar depending on which settings
you’ve selected (brown: every day, red: specific dates, orange: specific days).
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8.

You will notice the two messages you scheduled have been grouped into Play List A. If you add a single
message at a given time, the message’s name will display here. Notice the brown bar extends from 12:00am to
12:00am to indicate that this message will play all day, every day.

9.

You can click the Plus Sign (+) next to the Play List name to reveal all of the messages contained in the group.

10. Click the Add button again to add another schedule entry.
11. Set the Time & Date to Start and Stop Each Day. This activates the Start Time and Stop Time fields below.
12. Set the Start Time to 11:00am and the Stop Time to 2:00pm. Leave the other field set to All Dates to play
every day.
13. Click the EasyArt tab this time to display the list of pre-made EasyArt on your system. Find the Clouds
message and double-click it to add it to the Play List.
14. Click the Save button. You will return to the Schedule screen.
15. You will notice that your scheduling window now shows Clouds in a brown bar that only extends from
11:00am to 2:00pm. This is the only time of the day that this message will play on your sign. The brown bar
indicates that it will play every day. Also notice that the message name appears rather than a Play List name.
This is because it is the only message scheduled to play at those specific times.
Now let’s add a message that will only play on specific dates. This is an excellent capability in case you want to
run a specific set of messages over a given holiday or event.
16. Click the Add button to open the schedule details window.

DOUBLE-CLICK MAGIC • In order to move a message from the messages list into the Play List, you can simply double-click
the file name rather than using the Add button.
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17. Set the Time & Date to Start and Stop Each Day. Set the Start Time to 8:00am and the Stop Time to 8:00pm.
18. Under Start Time, set the other drop-down menu to Range of Dates to activate the date menus.
19. Enter next Thursday as your First Date and next Sunday as your Last Date.
20. You can leave the Days of the Week set to Every Day of the Week. The date range we just specified will ensure
that our message will only play Thursday through Sunday.
21. Click the EasyArt tab to display the list of EasyArt messages.
22. Scroll down the list and locate the message Clouds2. Double-click it to add it to the Play List.
23. Click the Save button. You will return to the Schedule screen.
24. Notice that the scheduler shows the Clouds2 message label in the timeline as grey. This is because we are
not viewing next Thursday. Click the Calendar icon above the timeline and select next Thursday from the
calendar. Click OK to move to that date. Now you will notice that a red bar appears from 8:00am to 8:00pm as
we selected. You can use the Forward and Backward Arrow buttons next to the Calendar button to move one
day in either direction.
The Clouds2 message will have a red bar on Thursday through Sunday only. The red bar indicates that the
message has been set to play on a specific range of dates.
Lastly, we will add a message to play on a specific set of days every week. This allows you to schedule a set of
messages for Monday through Friday and another set for the weekend.
25. Click the Add button to open the schedule details window.
ADVANCED
TOPICS

26. Set the Time & Date options to All Day and All Dates.
27. Set the Days of the Week to Specific Days of the Week. This activates the daily checkboxes.
28. Check the Monday, Wednesday and Friday boxes only. Uncheck any others.
29. Click the EasyArt tab and double-click the Flag Waving file name to add it to the Play List.
30. Click the Save button. You will return to the Schedule screen.

PREVIEW OFTEN • Use the Playback Time Indicator to preview what your sign will look like at any given time. Messages will always run in
order from the top of your list to the bottom.
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If you are not on a Monday, Wednesday or Friday date then the timeline label details will appear in grey. Click the
Calendar icon above the timeline and select any Monday, Wednesday or Friday. You can also use the Forward and Back
Arrow buttons.
When you are on one of these days, you will notice the Flag Waving message has an orange bar from 12:00am to
12:00am. The orange bar will only be visible on Mondays, Wednesdays and Fridays indicating that this message is only set
to play on these specific days, every week.

Other Schedule Setting Options
When you have added messages to your schedule, you probably noticed several more options in each of the drop-down
menus. Below is an explanation of each option.
Time & Date
All Day: This will make your message play from 12:00am to 12:00am on every day that it is scheduled to play. You can
then select from these sub-options:
All Dates: Your message will play all day, every day.
Forever Starting on a Specific Date: Your message will play all day, every day, starting on the specific date you select.
Range of Dates: Your message will play all day, every day, during the range of dates you selected.
Start and Stop Each Day: This will make your message start and stop at the times you select each day it is scheduled to
play. You also have access to the previous sub-options.
Forever Starting at a Specific Time & Date: This will make your message start at a determined time and date then play
all day, every day from then on.

KEEPING TRACK • When you are setting up messages to run on or through a specific date, it is helpful to put that date at
the beginning of the file name. That way you will know when to take it out of your schedule and when it can be deleted from
your message files.
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From Start Time To Stop Time & Date: This will make your message play from a specific Start Time and Start Date to a
specific Stop Time and Stop Date.
Days of the Week
Every Day of the Week: This will make your message play every day of the week within the range of dates you selected
and time frame selected.
Monday through Friday: This will make your message play Monday through Friday within the range of dates you
selected and time frame selected.
Saturday and Sunday: This will make your message play Saturday and Sunday within the range of dates you selected
and time frame selected.
Specific Days of the Week: You now have access to the checkboxes associated with each day of the week. Check the
boxes with each day that you want your message to play. This will make your message play on those specific days
within the range of dates you selected and time frame selected.
The Options Tab
In the Play List Details window you have a tab at the right labeled Options. This tab allows you to set a few specific
characteristics of your Play List if you choose.
Play List Name
This option allows you to manually type in a new name for the Play List you are creating or have created. By default,
Ignite will assign the name Play List A and continue alphabetically.

Play One Message per Loop
When this option is selected, only the first message from this Play List will play before moving on to the next playlist.
On the following loop, only the second message from this Play List will display, and so on.
Play Count
If you want the Play List you are creating to play more than once before the next scheduled playlist is seen, enter the
number of repetitions you want here. To play more than once, this must be set greater than one.

ON TIMES • The On Times feature is the best way to schedule your sign to be off at night. On the Schedule page, select On Times from the
Schedule drop down menu in the toolbar. Deselect the “Run the sign 24 hours a day” checkbox and adjust the On Times. These settings will
override all playlists in your schedule.
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Override
If you check the box in this section, your Play List will override any other messages that are set to play in that specific
timeframe. By default, Ignite simply adds your new Play List to any other messages that are scheduled to play at the
same time.

Adding and Deleting Existing Messages/Play Lists
If you want to delete an entire playlist of messages from your schedule, first click on the name of the Play List to
highlight it. Click the Remove button above the timeline. Click Yes to confirm the deletion of the Play List.
If you want to delete an individual message within a Play List, you must first click the Plus Sign (+) next to the Play
List name to reveal the messages within that list. Click on the name of the message you want to delete to highlight
it. Click the Remove button above the timeline. Click Yes to confirm the deletion of the message.
To delete a single message from a Play List, you can also click the Play List name to highlight it then click the Edit
button above the timeline. This opens the Play List Details window with your Play List of messages on the left.
Double-click the name of the message you want to remove to make it disappear. Click the Save button.

Available Schedule Views
Your schedule now consists of all three types of messages: Every Day, Weekly and Dated. This can become confusing
without a good way to view your upcoming messages. Ignite gives you multiple ways to view
and manage your play lists.
The View Settings in Ignite can provide you with an overall view of an upcoming week or even upcoming month. Let’s
look at how to use the View Settings.
1.

With the Schedule screen open, click on the View menu on your Menu Bar at the top of the screen.
2. Click Weekly. Notice that you now can view an entire week’s play list.
3.

Click on the View menu again and select Monthly. You can now view the Play List for the next
four weeks.

4.

Click on the View menu again and select Play Lists. This menu allows you to view your play lists in a textbased format. The column headings include the play list Name, When the play list is scheduled to play, and the
Messages contained in each play list.

You can still use your Playback Time Indicator to preview any time on the schedule in either the Daily, Weekly or Monthly
view to see what will be playing at that time on that day.

PUBLIC SERVICE • You will find that your sign can become a great public relations tool by using it to run occasional public
service and community interest messages.
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Using the File Manager
As you gain experience with Ignite, you might be surprised by the sheer volume of messages you build up over time.
Some will never be needed again after their initial use, while others are seasonal or concern matters that will be repeated
later. Some you need to delete, and some you should save for future use.
Moving and renaming message files is done easily from the File Manager. You can also change the Description and
associated Categories from the File Manager as well.
From the Messages screen, click File in the menu bar at the top of the screen and select Manage Files to display a list of
the messages you have created and saved.

Open
If you click on a file name and then click the Open button, the message will load in the Message Editor. You can then edit
your message as desired. Remember to save it when done to keep the changes.
Preview
Click on a File Name and then click the Preview button to see the message play. Click anywhere on the screen to stop
the preview.
Copy To
You may choose to store some messages in a location outside of Ignite. They might be seasonal, such as Holiday
messages, or they might be specific to your type of business or profession but not needed until some future time. You may
also want to save a copy of some messages on a Network Drive, CD or USB drive. To save a copy of a message file to the
desired location, highlight the file by clicking on it, then click the Copy To… button. Click the Browse... button to identify
the intended destination, then click Copy to move a copy of the message file to the new location.

CLEAN HOUSE • Don’t let your list of available messages grow so large that you have trouble locating and scheduling the
messages you use regularly. Delete files that you no longer intend to use on a regular basis.
MOVE ’EM ALL • If you want to copy multiple files at once, click on the first file name to highlight it. Hold down the Control
(Ctrl) key on your keyboard while you click on the other file names you wish to move.
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Copy From
If you have created message files on another computer, you will want to save them to a system that can update your sign.
The Copy From… button allows you to import files from a CD, USB drive, or network location so you can schedule them
to play.
Click the Copy From… button. Click the Browse… button and locate the files you want to bring in. When files exist in the
location you specify they will display in the Copy From… window.
Click the Message Files you want to import, then click the Copy button in the lower-right portion of the Copy From… window.
Your file(s) will then appear in the list of available messages.
Rename
If you only wish to rename a file, click the Rename button. Type the new name in the window that opens. Click OK to
accept the changes.
Delete
To delete a file permanently from your computer, click on the file name to highlight it. Click the Delete button. Files are
placed in the Recycle Bin to avoid accidental deletion. You will then be prompted to confirm the deletion of the file. Click
Yes to complete the deletion.
Properties
To display the current properties of any file, click on the File Name to highlight it, then click the Properties button. The
description and category of the message can be edited here.
Up to five categories can be used for an individual message.
Click OK to accept any changes.

UTILITY
PROGRAMS

DROP THE PRACTICE • Most users create a number of messages when first learning how to use the many features of the Ignite system. Use
the Delete instructions here to get rid of them when you have finished those early learning exercises.
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Message Logging
Ignite includes the ability to track and record what messages have played on your sign through Message Logging. This
function is off by default and can manually be enabled. You can generate a simple text-based report, which can be parsed
into a spreadsheet program, or you can generate a more detailed report through Ignite. In order to generate a logging
report, messages must be playing on your sign. There are two types of Message Logging: Simple and Detailed. Their
differences are explained below.
From the Messages screen, click Tools in the menu bar at the top of the screen and select Message Logging to display a
screen which prompts you to first connect to your sign.
Click the Connect button. A window opens which shows that Ignite is connecting to your sign.
A new Message Logging window then displays.
In the Settings section you must first decide if you want to generate a simple or detailed log report. Ignite, by default, is
set to simple, which means the drop-down menu says No. Let’s first generate a simple log.
Simple Message Log
Under the Settings section, make sure the Detailed Message Logging drop-down menu is set to “No” and then click Clear
Log and Start Logging On All Messages. This will send a command to the sign to start tracking what messages have
played. When the window that opens says that the sign was successfully set, click the Close button.

Message Log Format

Disconnect Button

Wait at least one minute from the time you enabled message logging so a number of your messages will have played. Under
the Log File section click Retrieve Logging File (message.log) to open a window displaying the details of your schedule.

50 | Message Logging

A Simple Message Log is a plain text file with the .log file extension and is automatically saved in the Ignite folder.
A simple log will have four columns as follows:
Message Name
Message Start Time
Total Message Playtime in seconds
Number of Occurrences the message has played
Be aware that the message name will be truncated to eight characters. Because it is a text file, the simple log can be
parsed into a spreadsheet program for further organization or editing.
Click File then Exit to close the message log.
Detailed Message Log
Now we will set up the system to generate a Detailed Message Log.
Click on the Disconnect button below the Settings section. Once disconnected, click the Connect button again to
reestablish communications with the sign.
Under the Settings section, change the Detailed Message Logging drop-down menu to “Yes.” Click Clear Log and Start
Logging On All Messages to start logging the playlist. Click the Close button on the new window that says, “The sign has
been successfully set.” Let the sign play through for a minute or so before trying to retrieve a log. Click Retrieve Logging
File (message.log) to open a window containing the details of your schedule along with a horizontal bar graph of the
time each message has played.
Display Buttons

Filter Drop-Down Menus
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EASY MATH • If you don’t remember how long a particular message is, simply divide the Total Message Playtime by the number of
occurrences. This will give you the message’s duration in seconds.
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A Detailed Message Log will display detailed information regarding your current schedule. You have several options
available to filter the log results including by month, by date, by hour and by message. Use the four Filter drop-down
menus to filter accordingly. You can also use the three Display buttons to change the display detail to month, day or hour.
The Detailed Message Log can only be viewed in Ignite. You can, however, print the log by clicking File then Print, or by
using the Print button on your keyboard.
Click File, then Exit to close the message log window.
Click the Disconnect button below the Settings section to close your communications with the sign.
Click the Edit button in the black bar to return to the Messages screen of Ignite.
Logging a Specific Set of Messages ($ Messages)
You can selectively log messages by using a “$” in front of the message file name. For example, “$ WE’RE OPEN” instead of
“WE’RE OPEN.” When you have $ Messages playing in your schedule, you can then select Start Logging On $ Messages on
the Message Logging screen. The other messages in your schedule will not be tracked and the returned results of the log
will only display the messages with a dollar sign ($) in front of them.
This method allows you to designate a specific group of messages to track. If you charge for advertising on your sign, you
can filter out your regular messages and only track the ones you charge money for playing.

HELP IS HERE • Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC
has Internet access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire
KnowledgeBase!
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Message Design Guidelines
The Ignite message editor makes creating content for your sign simple and is easy to use. Designing a message that grabs
the viewers attention can sometimes be complicated however. To assist with this issue, the Watchfire Creative Services
department has assembled a selection of tips and tricks to help ensure that your sign looks as good as possible.
Keep it Simple
The first step to creating an effective message for your sign is to use appropriate text in your message.
Keep the wording concise.
Avoid spelling out complete sentences. Don’t use eight words when four will do.
Stick with short, simple words to maximize quick comprehension by passing motorists.
Keep it Clean
Avoid using thin fonts as well as most script fonts. The strokes are simply too thin to maintain legibility on an electronic
sign. Stick with thick, heavy fonts to maximize readability.
In Ignite, it is strongly recommended to keep the bold feature on and to use a black outline around all text when possible.
Use all capital letters whenever possible. Capital letters use more pixels to create the letter which means they are
typically much easier to read from a distance.

sans-serif

MESSAGE DESIGN • Message Design in a sentence: Keep it simple, clean and big!
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serif

Keep it Big
Typically, your main audience consists of passing motorists traveling anywhere from 25 to 65 miles an hour. Keep your
text large! Large text allows motorists to see your message from a much greater distance without distracting them from
their main concern: driving. If your text is too small, it will be too hard to read, and your key audience is likely to disregard
your messages entirely! Although your sign is probably capable of much smaller, it is a good idea to use a minimum 12"
character for optimal viewing distances. Use multiple frames if your message won’t fit cleanly in one frame.
Bad

Too much text and too small. Passing motorists will not be able to read this entire message.
Good

Frame 1

Frame 2

Frame 3

By removing some words and spreading the text over multiple frames, you can use larger text so passing motorists will be
able to read your message more easily.
Remember our guideline; set each frame’s Hold Time to at least one second per line of text.
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HOLD TIMES • When in doubt, set each frame’s Hold Time to at least one second per line of text.
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Effective Color Schemes
High color contrast is a key ingredient to a successful message. Just like using large text and capital letters, the right
color combination can make your message readable from a much greater distance. Refer to the samples below for many
of the best text color vs. background color combinations for your electronic sign. As always, a black outline is recommended
to help distinguish the text from its background.

COMPLEMENTARY COLORS • High contrast color combinations are often called “Complementary Colors.” These colors are
directly opposite of each other on the color wheel.
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Image Resolution
Image resolution for an electronic sign is dependant upon the total number of pixels in the image. In print, resolution
is dependant upon the DPI (dots per inch) or PPI (pixels per inch). This number has little to no impact when displaying
images on your sign. Instead, you want at least as many pixels in your image as you have in your sign. Having more pixels
in your image allows you to crop more tightly without losing image quality. Watchfire recommends using images with at
least five times as many pixels than your sign has in both height and width.

Creating Custom Content
While the Ignite message editor offers many tools for creating excellent content for your sign, skilled graphic designers
may choose to use third party software to create custom artwork. Here are some recommended formatting guidelines to
ensure your graphics look their best on your sign.
Canvas/Composition Size
From a design standpoint, most electronic signs have very few pixels. However, the imagery looks much cleaner than
expected due to the light diffusion which occurs when the LEDs are illuminated.
For optimum results, create your compositions at least five times the sign’s height and width in pixels. For example, if you
have a 48x112 sign, you would want to create a composition at 240x560. You could even go to 10 times the sign’s size if
you have a smaller sign. The key is to increase in even increments of both the height and width of your sign. Ideally, you
want at least 200 pixels in each direction to work with.
Now when you import your imagery into Ignite, you won’t have to worry about cropping or distortion. The image will be
down-scaled perfectly to match your sign.
The same principle applies to video content. Most video content will either be shot in a 4:3 (standard definition) ratio or
16:9 (high definition) ratio. Each size will typically have plenty of resolution for your sign. However, if you decide to scale
down the video content to save file size, remember that you still want at least five times the number of pixels in each
dimension of your sign.
Frame Rates (for animated content)
For XVS signs, create your content at 30 fps (frames per second).
For W-Series signs, create your content at 20 fps.
File Formats
Still images can be imported as JPG (jpeg), GIF, or BMP (bitmap) files. Keep in mind also that they must be in RGB color
format, not CMYK.

DPI • Most users create a number of messages when first learning how to use the many features of the Ignite system. Use the Delete
instructions here to get rid of them when you have finished those early learning exercises.
OPTIMAL RESOLUTION • For easy image manipulation, create a source image at five times the resolution of your sign. It’s important to
understand that the image will be resized for the sign once it is imported.
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Animation and video importing requires an appropriate codec to be installed on your computer to support reading video
data from the file. In addition to the codecs Microsoft ships with Windows, many third party codecs are available to
support a wide variety of video file formats. Visit article 706 on the Watchfire KnowledgeBase for a full list of compatible
codecs. (Go to watchfiresigns.com/kb and search 706.)

Software Training
Watchfire has developed the most user-friendly software package in the industry. Ignite is set up for quick, easy learning
yet contains enough horsepower to cater to the most demanding content developer. If you ever reach a stumbling block
or would like to go beyond the Ignite manual, you can choose to participate in a web-based training option to take your
content creation to the next level.
Web-based training is an excellent option for users who have access to the internet at their location. A Watchfire trainer
can take control of your computer screen and guide you through the steps of creating content for your Watchfire sign.
We also use this method for general Ignite overview sessions. Attendees from multiple locations can connect to the
same session, which makes this an excellent option for users with employees in remote offices. Audio is handled via
a standard conference call. Watchfire will provide a common phone number for all attendees to dial into. Web-based
sessions are typically 1 to 1 ½ hours in duration. Check the front cover of this manual to see if training was included with
your sign’s purchase.
Schedule convenient, online training at watchfiresigns.com/ist
Minimum internet connection: Cable modem, DSL or better Internet connection
Web browser: Internet Explorer 8 or newer, Mozilla® Firefox® 24 or newer, or Google™ Chrome™ 23 or newer

ONLINE SCHEDULING • Schedule convenient, online training at watchfiresigns.com/ist
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Quick Message Guides
Creating a Text Message
1.

Click on the Create New Message button on the Messages screen.

2.

Type in text and adjust your text properties to your preference.

3.

Select the Effects tab and adjust effect properties to your preference.

4.

Select the Background Tab and apply background properties to your preference.

5.

Save your message by clicking the Save icon on the black toolbar.

6.

Give your new Message a name and description that will help you remember it in the future.

7.

Click on Save. Now your message is ready for scheduling.

Time and Temperature Messages
1.

Click on the Create New Message button on the Messages screen.

2.

Click on the Time icon and select your desired setting. Choose your desired text properties.
Adjust the placement of the time on your Frame View.

3.

Click on the Date icon and select your desired setting. Choose your desired text properties.
Adjust the placement of the date on your Frame View.

4.

Click on the Temperature icon and select your desired setting. Choose your desired text
properties. Adjust the placement of the temperature on your Frame View.

5.

Select the Effects tab and adjust effect properties to your preference.

6.

Select the Background tab and apply background properties to your preference.

7.

Save your message by clicking the Save icon on the black toolbar.

8.

Give your new message a name and description that will help you remember it in the future.

9.

Click on Save. Now your message is ready for scheduling.

HELP IS HERE • Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC
has Internet access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire
KnowledgeBase!
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Quick Start Import Image
1.

Click on the Quick Start Import Image button on the Messages screen.

2.

Choose a picture to import by clicking on the browse button.

3.

Highlight the image you want and click Open.

4.

Leave the color conversion set on True Color-Halftone (or Grayscale-Halftone).

5.

Adjust the Scaling Factor based on your preferences.

6.

Import the image.

7.

Add additional text to the image.

8.

Select the Effects tab and adjust effect properties to your preference.

9.

Select the Background tab and apply background properties to your preference.

10. Save your message by clicking the Save icon on the black toolbar.
11. Give your new message a name and description that will help you remember it in the future.
12. Click on Save. Now your message is ready for scheduling.

Quick Start Import Animation
1.

Click on the Quick Start Animation button on the Messages screen.

2.

Choose a video to import by clicking on the browse button.

3.

Highlight the video you want and click Open.

4.

Leave the color conversion set on True Color-Halftone (Grayscale-Halftone).

5.

Adjust the Scaling Factor based on your preferences.

6.

Add text and adjust the text properties to your preference. Use the Utilities button to apply text properties to
multiple frames.

7.

Save your message by clicking the Save icon on the black toolbar.

8.

Give your new message a name and description that will help you remember it in the future.

9.

Click on Save. Now your message is ready for scheduling.

IMAGE FILE FORMATS • Ignite accepts JPG (jpeg), GIF, or BMP (bitmap) files in RGB format. Ignite may also accept more unusual formats
such as ICO.
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ANIMATION FILE FORMATS • Ignite accepts uncompressed AVI files along with WMV files as long as the proper codec is installed. Visit
answer 706 on the Watchfire KnowledgeBase (watchfiresigns.com/kb) for more details.

How to Create a Basic Schedule
1.

Click the Schedule button in the Task List on the Messages screen.

2.

Click the Add button to open the message detail window where a new Play List will be created.

3.

Select the Date and Time information desired from the drop-down menus and checkboxes.

4.

Click the Messages tab or the EasyArt tab and double-click on the file name of choice to add it to the playlist
on the left.

5.

Click the Save button to return to the Schedule screen where you will see your Play List created.

6.

Slide the Playback Time Indicator over the area your Play List is set to run and watch the Schedule Preview
window at the bottom of the screen to be sure your message scheduling is correct.

How to Update Your Sign
1.

Click the Update Sign button in the Task List on the Messages screen.

2.

Type you password into the Password Box. If you haven’t set up a sign password yet, refer to the Password
Protect Your Sign section on page 63.

3.

Click the Update All Messages button.

4.

If the update was successful, the window will close and the screen will say, “Your sign was successfully
updated.” If an error occurs, the window will stay open displaying the error.

5.

Check out your messages on your sign.

HELP IS HERE • Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC
has Internet access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire
KnowledgeBase!
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Passwords
Password Protect Your Sign
Watchfire highly recommends setting a sign password.
1.

Click on the Tools menu at the top of the screen and select Configuration.

2.

Click Get Sign Controller Status to connect to your sign.

3.

Click the drop-down menu next to Password Protected and select Yes.

4.

You will then be prompted to enter a password. After a password has been entered, you will get a warning box
saying that a password is set. Read the warning and click OK.

5.

Click the Disconnect button to disconnect from your sign. After you disconnect from your sign, you will
always have to input this password to connect to your sign.

Password Protect Ignite
This password will be required upon opening the Ignite content management system. This feature is helpful when using
Ignite on a shared PC. It’s typically not needed if you have a unique Windows login that is password protected already.
1.

Click on the Tools menu at the top of the screen and select Configuration.

2.

Click on Ignite Setup from the Task List on the left side of your screen.

3.

Click the drop-down menu next to Password Protect Ignite and select Yes.

4.

You will then be prompted to enter a password. After a password has been entered, you will get a warning box
saying that password protection has been turned on. Read the warning and click OK.

5.

Click Save towards the bottom of your screen. If you do not click Save, the password will not take effect.

WHAT’S THE PASSWORD? • Be sure to write your password down and store it in a safe place.
CHANGING YOUR IGNITE PASSWORD • After creating and saving a password for Ignite, you will notice a Change button appears next to
‘Password Protect Ignite’. This will allow you to change your password at any time.
ADDITIONAL
INFORMATION
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Basic Terms
A few of you may be computer experts and will have no problem understanding the terms in this manual. But for those of
you who are not, we have included the following glossary to help you understand some basic terms you will find in Ignite.
Animation: Moving graphic or video clip. A large number are available in the EasyArt library that comes with Ignite.
Background: The layer of color behind the text and graphics layer.
Codec: A software component used to read audio and video data from files on your computer. Microsoft Windows ships
with codecs for many formats, including Windows Media Video (WMV). Many third party codecs are available to support
a wide variety of video file formats.
Cut/Copy/Paste: Simple tools found on the edit menu in Windows programs to move or copy information from one
place to another. You can also use the following shortcuts in Windows (and in Ignite) to accomplish these tasks once an
item or text is highlighted: Cut: Ctrl + X, Copy: Ctrl + C, Paste: Ctrl + V
EasyArt: The library of pre-made messages that comes with Ignite content management system.
Effects: Effects manipulate the way a frame Appears, Holds and Exits your sign. Clicking on the Effects tab takes you to
this area.
Font: The style of text.
Frame: An individual slice of a message consisting of Text, Graphic, Background layers and Effects. A series of frames
makes up each message.
Global Change: A change made to all frames of a message at one time.
Highlight: Clicking on an item frame, or picture, or clicking at the beginning of text and moving your mouse across while
holding the left mouse button down causing the text to change color.
Import: Inserting images or animations into a message from another source.
JPG/GIF/BMP: Types of photo and/or image files that can be imported into a frame.
Justification: Horizontal text alignment either to the right, left or center.
Layers: An individual frame element that is independently drawn on a single plane. Each frame contains three layers:
Text, Graphic and Background.
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Menu/Drop Down Menu: A list of choices displayed by clicking on the small triangle button.
Message: A series of frames stored in a file.
Monochrome: A sign that is only one color. Monochrome LED message centers are typically Red or Amber.
Pointer: The little arrow that moves when you move your mouse.
Schedule: Tells your sign what messages to run and when to run them.
Shadow: The border color around text used for accenting and giving the appearance of depth.
Tabs: Label at the top of a window that switches you to another section.
Thumbnail: A small picture showing a preview of what a message looks like. Any frame of a message can be selected as
the thumbnail. If none is selected, the first frame will automatically be chosen.
Utilities Button: The button found on most tabbed sections in the Message Editor. It is used to make Specific, Global or
Default (from now on) changes across multiple frames of your message.

ADDITIONAL
INFORMATION
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Frequently Asked Questions
Can I change a single frame’s properties after I have used the Utilities button to change multiple frames?
Yes. Changing multiple properties with the Utilities button only sets the multiple frames to the same thing at that
point. You can then go through your message and make as many further changes as you want.
What if I forget my password or the person who knew it quits?
First, verify that your sign requires a password by trying to update it while leaving the password field blank. If a “Error:
Invalid Password” prompt is received, contact Watchfire Technical Support at 866-637-2645 or visit watchfiresigns.com/chat.
My sign is not working properly. What information do I need to have available before I contact Tech Support?
You need the name of your company, the location of the sign and a basic description of the problem. It’s best to have
the sign’s “Sales Order Number” readily available.
How do I change how long a message plays?
You change how long messages play by adjusting frame hold times.
How many different messages can I set up in my schedule?
You can have as many as you need. Different messages can be set up to play every day of the year if you want.
How do I put my logo on my sign?
Using the Quick Start Image feature, import your logo as a compatible file type, such as Bitmap, GIF or JPG.
My sign is blank; what do I do?
Check the preview sign on the Schedule page in Ignite. If blank, schedule messages. Attempt to update the sign once
more. If the sign remains blank, refer to the “Blank Sign Troubleshooting” answer on watchfiresigns.com/kb.
How many frames can each message have?
A single message can contain up to 500 frames.
Most of my messages have disappeared from my message list. What do I do?
Be sure you have your category list set to All Categories.
How do I save and restore my existing schedule?
While in Schedule Mode, click on SCHEDULE at the top of the screen. Click on EXPORT SCHEDULE and choose a
destination for the exported file (the default will be your C: drive and the file name will be C:\signname.SCHED). Click OK.
Change, delete or add to your schedule.
When you are done training, click on SCHEDULE at the top of the screen again, choose IMPORT SCHEDULE, highlight
the file “signname.sched” and click OPEN at the bottom of the screen. Click OK. Your saved schedule is now restored.
For additional information, please go to our online KnowledgeBase at watchfiresigns.com/kb. Here you can search for
answers to questions that we may not have covered in this section of the manual. If you don’t find the answer you’re
looking for, click on the Live Chat tab for personalized help.

THE KNOWLEDGEBASE • The Watchfire KnowledgeBase, found at watchfiresigns.com/kb, is constantly updated by our
technical staff. It’s full of useful tips, tricks, videos and troubleshooting guides. It’s the best and most exhaustive source for
“Frequently Asked Questions.”
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PC Requirements
A personal computer (PC) is needed to run Ignite, the application used to create and send messages to the sign. A new
sign owner has two choices for a PC to operate their new Watchfire sign:
1. Order New PC From Watchfire®1
All needed hardware & software pre-installed.
Sign & PC tested together prior to shipment.
2. Using An Existing Computer
Below are the minimum required specifications to ensure Ignite operates properly. Our helpdesk can only resolve
compatibility issues with computers provided by Watchfire, but most PCs will work.
Minimum requirements (all models, regardless of PC supplier):
Microsoft Windows 8 or 7 (32 or 64-bit), or Mac OS 10.10 or newer running Parallels Desktop 10.10 or newer (with
one of the previously listed OS’s)
1GB of RAM (2GB+ recommended)
5GB of available hard-disk space
Video card capable of displaying 64,000 colors (1024x768)
Internet Explorer 8.0 or higher
Two available USB ports
DVD-ROM
NOTE: Some sign communication methods add to Minimum System Requirements. Refer to Communication System Requirements below.

Communication System Requirements
The following communication system requirements are necessary in order to communicate with your Watchfire Sign:
1. Network Interface Card
Required for High Speed Fiber, RWF Radio and Broadband communications
2. Standard phone modem
Required for phone communications
3. Video Capture Card
Required for XVS Live Video

1

Laptop available; Time-O-Matic part #33989. Not compatible with Live Video or Video Capture.

ADDITIONAL
INFORMATION
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Notes
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800-637-2645
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